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1.0
INTRODUCTION

1.1
Identification of Document

This is the User’s Guide for the Ask Pete application developed at NASA Glen Research Center.  

1.2
Scope of Document

The information included in this version of the User’s Guide applies to Version 3..3.1 of Ask Pete.  The information contained here may or may not be accurate for any past or future versions.

1.3
Purpose and Objectives of Document

This guide will provide the information necessary to install and use Ask Pete.  It will also describe or reference the algorithms used to provide the project estimates and control level, which form the basis for the results the application generates.

Installation instructions include installing from either a CDROM or as a zipped file that has been downloaded from the Ask Pete web page.  

Instructions for using Ask Pete will concentrate on how to start and end the program, and the various options and screen displays the user will see.  A tutorial is included throughout the guide to familiarize the user with the program and demonstrate its capabilities.

1.4
Document Status and Schedule

The initial release date for Version 1.1 of the document was June 24, 1999.  Releases of future versions will coincide with updates to the application that affect the validity of the information presented in this guide. 

1.5 Documentation Organization

1. Introduction

Section 1.0 briefly describes the purpose of the User’s Guide and scheduled updates.

2. Related Documentation

Section 2.0 lists the reference documentation that was used to develop Ask Pete and references for the user when running the application.

3. Overview of Purpose and Functions

Section 3.0 provides an explanation of the purpose Ask Pete fulfills and briefly describes the functions of the application and the algorithms used to generate the estimates and control level determination.

4. Installation and Initialization

Section 4.0 lists the steps for installing Ask Pete from various media and formats.

5. Startup and Termination

Section 5.0 is not applicable to this document.

6. Functions and Their Operation

Section 6.0 provides detailed information concerning the operation of Ask Pete and includes screen displays the user will see while running the program and a tutorial.

7. Error and Warning Messages

Section 7.0 describes the warning messages the user might see when using the program.

8. Recovery Steps

Section 8.0 is not applicable to this document.

9. Abbreviations and Acronyms

Section 9.0 lists and defines the acronyms used in this document.

10. Glossary

Section 10.0 defines Ask Pete peculiar terms used in this document.

11. Notes

Section 5.0 is not applicable to this document.

12. Appendices

Appendix A lists the files included with the distribution files and the directories where they should be installed.

2.0
RELATED DOCUMENTATION

2.1
Parent Documents

Not applicable to this project

2.2 Applicable Documents

The following documents were used to develop, and are referenced in, the Ask Pete program:

DERA/COR/G052, Software Planning, version 1.0, release 208, effective date April 4, 1997, currently available from http://www.lerc.nasa.gov/WWW/iso9000/DERA/ebms/cor/bms_docs/corporat/G052_1.doc

Software Engineering Economics, Barry W. Boehm

Software Cost Estimation with COCOMO II, Barry W. Boehm

CLP LeR-M2.6.4, GRC’s Software Development Manual, Rev, A. 

This guide was prepared to comply with the format of NASA-DID-P600, User’s Guide

2.3
Information Documents

Not applicable. 

3.0
OVERVIEW OF PURPOSE AND FUNCTIONS

Ask Pete provides assistance in determining the effort, control strategy and documentation needed when planning a project.  It also provides a template software development plan and estimate of typical Software Product Assurance (SPA) activities associated with a project based on the responses provided by the user.  It is intended to be used by program managers, SPA and IV&V personnel when projects are initiated and when changes are made in the scope of project. 

3.1
Ask Pete Functions

Ask Pete determines the effort; control level and documentation requirements by characterizing a project using a series of questions.  The questions are based on a core set to determine the COCOMO II estimate and Control Level.  The NASA IV&V criteria is also used to determine if the project is a candidate for Independent Assessment (IA) or Independent Verification and Validation (IV&V).  Additional questions may be asked based on the responses given.  Once the characterization is complete, the program uses calculations based on COCOMO II, NASA Glenn Software Development Manual, the DERA/COR/G052, Software Planning Document and the NASA Criteria for IV&V, to determine the levels of effort and control and IA or IV&V required for the project and the resulting recommended documentation requirements.  Once this has been completed, various results may be displayed on the screen and stored as a text files (.txt) or Rich Text Files (.rtf).  Currently, Ask Pete provides reports summarizing the entire project, a template Software Development Plan, a listing of the questions and responses, and a Software Product Assurance activity estimate.  The responses are stored in an Access database and can be reviewed and modified.  The .txt or .rtf files can be reviewed, saved and printed.  

3.2
Ask Pete Options

At the present time, Ask Pete provides:

· File options for creating, editing or saving project information, as well as reviewing and entering project file properties.

· Project options for creating, opening and comparing versions of a project and generating various reports.

· Tool options for displaying or hiding the toolbar and status bar, adjusting the average hourly rate and average hours in a PersonMonth to be used in the cost estimates and the ability to modify the activity estimates.

· Windows options for arranging, displaying, and selecting various project and report windows.

· Help options to view the help file, information about the program and links to the support web site.

3.3
Ask Pete Restrictions and Limitations

Ask Pete is limited to storing project information for a maximum of 255 projects.  At the present time there are no other restrictions and limitations on the use of Ask Pete.

4.0
INSTALLATION AND INITIALIZATION

Note:  These instructions are for installing the application on a computer with Windows 95/98/2000/NT operating systems.

Ask Pete is distributed in one of two formats.  The complete installations and updates.  

4.1 Complete Installations

Complete installations use an InstallShield installation file and include the application, all documentation and all databases.  To install the application, unzip the distribution file if necessary into a temporary folder.  Run the Setup.exe from whatever location the installation files are stored.  Accept or modify any options presented during the installation.  Note: if Ask Pete is to be used in conjunction with the JPL ARRT tool, both applications must be installed in the same folder.  The installation defaults to installing the application in the C:\Program Files\NASAToolTime folder.

The Typical installation will install the application, data and documentation files.  The Compact installation only installs the application and data files.  The Custom installation should be used to only install the application files when data already exists from using a previous version or when reinstalling the application since the Typical or Compact installations will overwrite the existing data.  A copy of the database should be created before using the Custom option to ensure the data is not accidentally overwritten during the installation.

The libraries and components must be registered using the install program if they do not already reside on the user’s computer.

Initial estimation factors, i.e. average hourly rate and typical hours in a person month, should be entered prior to using the application.  Reference section 6.2.5.2 for more information.

4.2 Updates

Updates are distributed with the application and documentation as a zipped file.  Unzip the files in the folder which contains the original installation.  Upgrade the databases, if needed, using the Tools – Convert option on the Ask Pete menu bar the first time the updated application is run.

5.0
STARTUP AND TERMINATION

This section is not applicable to Ask Pete.

6.0
FUNCTIONS AND THEIR OPERATION

Throughout this section of the User’s Guide, each of the menu options of the program will be explained.  A tutorial is also presented which will walk the user through the typical steps to create a project.  The tutorial will be included within the following sections, enclosed in vertical borders, denoted by Arial, 10 pt. Font and preceded by the tutorial step number as shown for step one:

Step 1: Run the Ask Pete program.


[image: image2.wmf]Figure 6-1, File Menu

6.1
The File Menu

Start Ask Pete from the Start-Programs menu.  After the start up screen closes, a project can be created or opened.  When the File menu option is selected, the screen shown in Figure 6-1 will be displayed.  Select the appropriate option from the File menu to create a new project, File – New; load an existing one, File – Open; or quit the program, File – Exit.  The Close, Save, Properties and Print options are only available when a project is open.

6.1.1
New Option: Create a New Project

After the File – New option from the menu has been selected or the New button on the toolbar is clicked, the dialog shown in Figure 6-2 will be displayed.  Enter a name for the project.  The name can be up to 50 characters and can include spaces.  It cannot contain an apostrophe (‘), period (.) or tilde(~).  

Projects can be created with the default COCOMO values pre-selected by clicking the Use default COCOMO II values checkbox.  This option is provided if the main planning focus is to determine the Control Level and IV&V results.  The COCOMO values can be modified or accepted later.  When a project is created using the pre-selected COCOMO II values, the reports will include a caveat which identifies that the COCOMO planning is not complete.  To remove this caveat, the COCOMO answers must be reviewed and modified to reflect the project’s characteristics and the comments associated with the COCOMO questions must be updated to indicate that this has been done.

Once the project has been created, a screen similar to that shown in Figure 6-3 will be displayed.

Step 2: Create a new project, zSample, by selecting the File – New option from the menu and entering “zSample” in the New Project dialog when prompted.


[image: image3.wmf]
Figure 6-2, Enter Project Name Dialog

6.1.2
Characterizing a Project

Once a project has been opened or created, a Project Characterization Window similar to the one shown in Figure 6-3 will be displayed.  Characterizing a process is performed by answering a set of questions from five or six categories in the Project Characterization Window.  The categories and questions are presented in a tree format.  

Initially, the question tree is collapsed and only shows the project name and the possible categories:

· COCOMO

· Control Level

· Control Level and COCOMO

· IV&V

· Reuse

· SLOC

· SW, Docs and Activities

When a project is open, the status bar at the bottom of the screen provides Control Level, COCOMO Schedule, COCOMO Cost and KSLOC estimates for the project.  Until all applicable questions have been answered “Unknown” is displayed for these estimates.  

Clicking on the desired category can expand each of the category’s nodes on the tree.  Figure 6-4 shows the zSample Project with the Control Level category expanded.


[image: image4.wmf]Figure 6-3, Project Characterization Window

Each category and question is preceded by a red, green or blue colored dot.  The red dot signifies that a question has not been answered or a category still has unanswered questions.  Green dots signify that a question has been answered or all of the questions in a category have been answered.  A blue dot means that the question is not applicable to the project or the category contains only questions that are not applicable to the project.  As questions are answered or answers are changed, additional questions may be triggered or no longer apply to the project.  The dots preceding triggered questions will change from blue to red.  The dots preceding inapplicable questions will change to blue.

Above the question tree are two boxes labeled Total and Answered.  The number in the Total box shows the number of questions applicable to the project.  This number will change as questions are answered and other questions are triggered or removed.  The number in the Answered box shows the number of questions that have been answered.

Categories are expanded to show the questions either by clicking on the category with the mouse or by using the up and down arrow keys to highlight the category and then hitting the Enter key.  Questions are selected either by clicking with the mouse or highlighting with the arrow keys.  When a question has been selected, the question will be displayed at the top of the dialog above the drop down box.  Clicking on the arrow in the drop down box or hitting the A key displays a list of possible answers for the selected question.  Clicking on one of the answers with the mouse or using the arrow keys to highlight and answer and then hitting the Enter key, answers the question.  The question’s dot in the question tree will turn from red to green and the number in the Answered box will be incremented.  If the answer triggers one or more additional questions then the number in the Total box will be incremented appropriately and the triggered questions’ dot(s) will turn from blue to red.  

When a question is selected, any comments you wish to save about the question can be entered in the Comment box under the question tree.  These comments are saved with the project and can be viewed any time the associated question is selected for the project. 

Step 3: Click on the SLOC and Control Level categories to expand them.  Notice that there are 57 questions to be answered and that the question 7 in the Control Level category, “7] What percentage of the program…” is blue, meaning it has not been triggered.  Click on the question “1] Estimate the number of new…” in the SLOC category.  The question will be displayed above the drop down box.


[image: image5.wmf]Figure 6-4, Control Level Node Expanded

Step 4: During this tutorial you will be characterizing the Ask Pete project.  Ask Pete was estimated at about 8,000 source lines of code (SLOC).  Open the dropdown box by clicking on the arrow and select 8,000 SLOC by clicking on “8,000”.  Notice that 8,000 now appears in the dropdown box as the answer to the question.  The dot before the question has turned from red to green to show that the question has been answered and the dot before the SLOC category has turned from red to green to show that all of the questions in the category have been answered.  Also notice that answering this question has triggered question 7 in the Control Level category and its dot is now red showing that it needs to be answered.  The number in the Questions box has increased from 57 to 58 and the number in the Answered box is 1.

Step 5: Answer the questions in the SW, Docs and Activities category by clicking on the category to expand it.  Two questions in this category need to be answered, 2 and 6.  Select question 2 by clicking on the question.  Notice that the answer “No” automatically appears in the dropdown box.  All questions with “Yes” or “No” as the only possible responses default to “No” when first selected.  Ask Pete is an interactive program so change the answer to “Yes” by clicking on the arrow on the drop down box and selecting “Yes”.  It takes a few seconds for the change to register because the program must check the new answer against all other answered questions to see if the change will trigger another question.

Ask Pete did not incorporate any existing code.  Select question 6.  The answer defaults to “No” which is the correct answer for this project.  Note that we have answered three questions as shown in the Answered box.

Step 6: Open the COCOMO category and select the first question, “1] Rate the organizational understanding…”.  Click on the [Help] button on the right above the question tree.  A Help window will appear which displays additional information about this question.  Once you are done reading the Help, click the close button to close the Help window.  The development team had a thorough understanding of the project requirements.  Select “Thorough” as the response to this question.


[image: image6.wmf]Figure 6-5, Selecting an Answer for a Question

For each of the questions in the COCOMO category, select the following answers:

2
Considerable
3
Some
4
Minimal
5
Basic
6
Basic
7
Low
8
A little
9
Generally
10
5% to 10%
11
Less than 20%
12
Little
13
Little
14
Less than 5 Non-Critical.
15
Full
16
Full
17
Considerable
18
Considerable
19
None
20
Right-sized…
21
50%…
22
50%…
23
Major change every 12 months…
24
75th percentile
25
55th percentile
26
1 year
27
3 years
28
3 years
29
Less than 3%…
30
Simple frontend…
31
Mostly simple nesting…
32
Evaluation of moderate-level…
33
No cognizance needed…
34
Single file subsetting…
35
Simple use of widget set

Clicking on question 36 causes the CMM Calculator dialog to appear with Requirements Management the current Key Process Area.  Select “Frequently” for KPA Performance by clicking on the Frequently button.  Select the next KPA by clicking on the Right arrow under the Key Process Area box.  The software Project Planning KPA will be displayed.  Select Frequently for it and all other Repeatable Key Process Areas.  Leave all other Key Process Areas at the default “Rarely, If Ever” option.  Click the Evaluate button to determine the CMM level to select.  Once the level is displayed, click the Exit button. 

Continue to complete answering the COCOMO questions

36
Level One (Top Half)
37
Moderate

Note that the COCOMO category is now preceded by a green dot signifying that all of the questions have been answered.  You may have to scroll up the tree to see it.  Now answer the Control Level questions:

1
Up to 5…
2
None…
3
Within own group or one business sector.
4
Proven; developers have some experience
5
Minimum testing
6
Simple Standalone
7
Less than 10%

Note that question 8 in this category is blue and does not require an answer.  Complete the Control Level category.

9
Less than $500,000.
10
All team qualified and experienced.
11
All software development tools...

Now complete the Control Level and COCOMO Category.  First click on the category to expand it and then answer the questions:

1
Unsatisfied Customer
2
Interactive Multimedia.
3
Nominal effort to meet milestones
4
No injury
5
No damage
6
Fully collocated...

Now complete the IV&V Category.  First click on the category to expand it and then answer the questions:

1
Less than $2,000,000.
2
No more than a center inconvenience

Note that Question 3 is blue and does not require an answer.

All 58 questions have now been answered and the status bar shows the following estimates for the project:

Control Level: Low (54)
COCOMO Schedule: 7.5 months and 8.5 Person Months
COCOMO Cost: $47,000
KSLOC: 8.4

6.1.3
Save Option: Saving Project Data

Ask Pete automatically saves answers as they are selected or changed to the database.  It also exports shared data or information that can be used by other applications.  The shared data is automatically exported when a project is closed.  Selecting the File – Save option when a Project Characterization Window is active will export the shared data of the active project at any time. Selecting the File – Save option when a project report is displayed will allow you to save the report as either a text (.txt) file or a Rich Text (.rtf) File. 

Step 7: Select the File – Save option.  Nothing visible will happen but the shared data has been exported to the Shared.mdb file in the Shared subfolder of the folder where the application is located.  This data can be viewed using Microsoft Access.

6.1.4
Properties Option: Viewing and Entering Properties for the Project

Just like a Microsoft Word document, you can view and save certain information about the project information itself.  You can also override the project characterization results and force certain activities to be included in the outputs for a particular project.  Selecting the File – Properties option displays a General dialog similar to the one shown in Figure 6-6.  

The Summary dialog allows you to enter information about the project that can be used to identify or compare the project with other similar projects.  

The IV&V dialog allows you to override the IV&V or independent assessment activities that would normally be recommended based on the project characteristics and force a certain group of activities to be selected.  Only one group of IV&V Activities (Basic, Limited, Focused or Comprehensive) can be selected at a time.  Independent Assessment activities can be selected along with IV&V activities or alone.  To clear the selections on the dialog, click the Clear all button.  If an IV&V or Independent Assessment override is selected, a message will be displayed on the project characterization form identifying which overrides are in place.  Selecting one of these overrides causes the appropriate IV&V activities to be selected as recommended PACTs when saved to the Shared database for users who have access the ARRT application.  The selection of these overrides has no visible effect on the operation or results of Ask Pete itself.

The Project Info dialog allows you to enter information about the project organization and requirements.  It contains fields for identifying the company, division, etc. responsible for developing the software; a contract, charge number or other identification for the project; The primary programming language to be used; and any applicable development specifications.  This information is included in the SQA reports.

The Contacts dialog allows you to enter the name and phone number of key contacts for the project.  This information is included in the SQA reports.

The Description dialog allows you to enter a brief description of the project or software.  This information is included in the SQA reports.

To save any changes entered in the dialogs, the OK button must be clicked.  Clicking Cancel merely closes the Properties form without saving any changes.


[image: image7.wmf]Figure 6-6, Project Properties Dialogs

Step 8: Select the File – Properties option. Click the Summary tab and enter your name as author, your manager’s name and company.  Enter “Planning” for Category, “cocomo, estimation, planning” for Keywords and “This is an exercise in using Ask Pete to characterize itself” for Comments.

Click the OK button.  And then select the File – Properties option again.  The information you entered has been saved and can be edited.  Hit the OK or Cancel buttons to close the dialog.

6.1.5
Close and Exit Options: Ending a Session

The Close option closes the currently active window.  If the window is a report which has not been saved, a prompt asking if the report should be saved will be displayed.  If the window is a Project Characterization Window, then the shared data will be automatically exported.  Once these operations are complete the window will close and the next window in the queue will become the active window.  

The Exit option closes all windows and exits the program.  If any project reports are open that have not been saved, you will be prompted to save them before they are closed.

Step 9: Close the project by selecting the File – Close option from the menu.

6.1.6
Open Option: Opening a Project

To view the project reports or modify the answers from an existing project, you must first open it.  Selecting the File – Open option displays a dialog similar to the one in Figure 6-7.  Click on the project to select it and then click on the Open button and the Project Characterization Window, similar to Figure 6-3, will be displayed.  
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Step 10: Open the zSample project.  Select the File – Open option.  Highlight the zSample project and click Open.

Figure 6-7, Open Project Dialog

6.2
The Project Menu

After a project has been created or opened and all of the applicable questions have been answered, the Project menu allows you to create or view a particular version of a project’s characterization.  It also allows versions of a project to be compared, provides a CMM Level estimation and creates several reports.


[image: image8.wmf]
Figure 6-8, CMM Calculator

6.2.1 Project – CMM Level

The CMM Level option brings up the CMM Calculator, Figure 6-8.  The CMM Calculator displays each of the CMM KPAs with a summary of the activities that are performed to satisfy each KPA.  Step through each of the KPAs and select the option that most accurately describes how successfully your team or organization has satisfied the activities in the past.  Once all KPAs have been responded to, click on the Evaluate button to determine the CMM Level.  To incorporate the results into the project, click on the Update button.  The CMM Calculator should only be used when a formal CMM assessment has not recently been performed.  The CMM Calculator is displayed automatically when the COCOMO CMM Level question is selected.

6.2.2 Project – Function Points

The Function Points option brings up the Function Point Calculator, Figure 6-9, that converts a function point estimate to a SLOC estimate which is used by the application for the cost and schedule estimates.  

The number of Low, Medium and High complexity function points are entered in the text boxes for each of the types of functions.  These values are weighted and the weighted sum determines the total number of function points for the project.  The programming language which the software will be developed in is selected from the Programming Language drop down list.  Once the language is selected, the function points are converted to a SLOC estimate.  


[image: image9.wmf]
Figure 6-9, Function Points Calculator

Clicking on the Reset button returns all of the values to the values that were displayed when the form was loaded.  

Clicking the Save button causes the SLOC estimate to be saved as the selection for the SLOC question on the characterization form and closes the Function Points Calculator.  Note: the actual Function Point SLOC estimate that is saved with the SLOC question is not the calculated value.  The Function Point SLOC estimate is rounded up or down to the nearest selectable value.  The estimate of 11991 shown in the figure would be saved as 10000 for the SLOC question.  Selecting another value from the available choices for the question can overwrite this value.

The Cancel button closes the Function Points Calculator without closing the form.  

6.2.3 The Report Menu

After a project has been characterized, five reports can be generated:

· Plan

· Results

· Responses

· Waterfall Model Based SPA Plan

· Control Level Based SPA Plan

Each of these reports can be saved either as a Rich Text File (.rtf) or as a text file (.txt) using the File – Save and edited using a word processor.  They can also be printed using the File – Print option.

Reports created in the Project menu are created dynamically based on the existing characterization of the project.  They cannot be loaded or viewed at a later time in Ask Pete after they have been created.

Multiple report windows can be opened at any time but a report can only be generated when the Project Characterization Window is active.  

6.2.3.1
Project – Report – Plan: Creating a Software Development Plan

The Project – Report – Plan option generates a fairly complete Software Development Plan (SDP) based on the Data Item Description (DID) DI-IPSC-81427.  The only customization that Ask Pete performs is to insert the Project name where applicable.  This plan should be saved and edited in using a word processor.  The content should satisfy requirements for a High or Critical Control project but should be tailored to conform to the activities associated with a Low or Medium Control project.  

Step 11: If the zSample project has not already been opened, open it.  Select the Project – Report – Plan option from the menu.  The zSample project SDP will be created and display in a new window.  Save the plan as a Rich Text File by selecting the File – Save option from the menu.  The save option defaults to saving as an .rtf file.  Save the file as zSampleSDP.

Step 12: Close the report by selecting the File – Close option.

6.2.3.2
Project – Report – Results: Viewing the Results of the Project Characterization

The Project – Report – Results option generates a report containing:

· all of the COCOMO factors, values and calculations which were used to generate the estimates

· the control level

· a listing of all required documents based on the control level

· a description of activities, by phase, that should be performed based on the control level.

· IV&V recommendations for Independent Assessment, IV&V if needed

· phase estimates showing the estimated staffing and effort by phase as well as for the entire project.

Step 13: Select the Project – Report – Results option from the menu.  The zSample project characterization results will be created and displayed in a new window.  Save the file as a text file by selecting the File – Save option from the menu.  Click the down arrow on the Save as type: combo box and select Text Files (*.txt).  Save the file as zSampleResults.

Step 13a: Only perform this step if your computer has access to a printer.  To print the Results report, select the File – Print option from the menu.  Modify the Printer dialog options as desired and click the OK button to print the report.

6.2.3.3
Project – Report – Responses: Reviewing the Questions and Answers

The Project – Report – Responses provides a listing of all questions applicable to the project as well as the possible responses to each question.  It also identifies the response that was selected for each question.  This report is a good tool for reviewing the project characterization with others.

Step 14: The Results report should be the active window if you continued from step 13 in the tutorial.  Try to generate the Responses report by clicking on the Project menu.  All of the options are disabled.  Click on the Window menu.  You should see an option, 1 Project: zSample, ver. 0, or something similar.  Select that option to make the Project Characterization Window the active Window.  Now select Project – Report – Responses.  The Responses report for the zSample project will be created and displayed in a new window.

6.2.3.4
SPA Plan Menu

The SPA Plan menu allows you to generate an estimate of SPA activities formatted around the waterfall lifecycle model or around the lifecycle model specified by the project’s control level.  More information concerning the types of SPA activities the report estimates is included in the help file.

6.2.3.4.1
Project – Report – SPA Plan – Waterfall Model Phases: Planning Software Product Assurance (SPA) Activities Based on the Waterfall Lifecycle

The Project – Report – SPA Plan – Waterfall Model Phases option provides an estimate of SPA activities and resources required for each phase of a typical development effort based on the waterfall lifecycle model and identifies the control level and documentation to be generated.  It serves as a starting point for planning SPA activities.

6.2.3.4.2
Project – Report – SPA Plan – Control Level Phases: Planning Software Product Assurance (SPA) Activities Based on the Control Level

The Project – Report – SPA Plan – Control Level Phases option provides an estimate of SPA activities and resources required for each phase of development effort based on the control level.  It identifies the control level and documentation to be generated and serves as a starting point for planning SPA activities.

Step 15: Make the Project Characterization Window the active Window.  Now select Project – Report – SPA Plan – Control Level Phases.  The SPA Plan report for the zSample project will be created and displayed in a new window.  Make the Project Characterization Window the active window and select the Project – Report – SPA Plan – Waterfall Model Phases option.  Compare the two reports.  You will notice that the Control Level based report identifies less phases than the report based on the waterfall model.  That is because the Control Level based development combines phases and activities for less critical projects.

Step 16: Once you are through reviewing the SPA Plan.  Close all reports using the File – Close menu option or clicking the Close button on the upper right corner of each report.  Do not close the Project Characterization Window.

6.2.4
The Versions Menu

The Versions menu allows changes in the scope of a project to be incorporated in the planning effort without losing earlier entries.  The two options in this menu allow a new version of a project to be created based on the original version’s entries and an earlier version of the project can be opened and reviewed.  Currently a new version of a project can only be generated from the latest existing version.  Attempting to create a version of an earlier version will result in a error because versions are created by incrementing the version number of the version being modified, i.e. if you have two versions of a project: version 0 and version 1 and try to create a new version of version 0 it will try name it version 1 which already exists.

During the development of Ask Pete, the decision was made to integrate the results from Ask Pete with another application.  This caused a change in the scope of the project that required adjustments to the estimates and plans.

6.2.4.1
Project – Versions – New: Creating a New Version of a Project

The Project – Versions – New option creates a new version of the currently active project.  This version can then be modified to adjust for changes in the scope of the project.

Step 17: The zSample Project Characterization Window should be the active window on the screen.  Once it is, select the Project – Versions – New option.  After a brief delay, the new version of the project will be displayed.  Select the Window – Cascade option from the menu.  You will see two Characterization Windows on the screen.  The active window will be the new version, zSample, ver. 1 while the inactive version will be the original, zSample, ver. 0.  The project name and version is identified in the caption at the top of the windows. 

Step 18: As a result in the change in scope of the project the following changes need to be made.

Expand the COCOMO category and change the following questions

1
Considerable
13
Some
15
Considerable
16
Considerable
17
Little
18
Basic

Expand the Control Level category and change the following question:

1
Between 6 and 10…
3
Other groups in own Directorate …
4
Proven but new to developers
5
Standard testing required
6
Integrated
7
10-20%

Expand the Control Level and COCOMO category and change the following question

1
Damage to GRC reputation

2
Narrow band email

6
Multi-city and Multi-company or multiple providers with associate relationship.

Expand the SLOC category and change the following question:

1
9,000

Notice that the change to SLOC question 1 moved the project into the Medium Control level and also triggered question 5 in the Software, Docs and Activities category concerning certification.  Answer “No’ to the question.

You can compare the results between the two projects in the status bar as each is made become the active window. 


Estimate
Version 0
Version 1


Control Level
Low (54)
Medium (100)


Schedule (mo)
7.5
9.1


Schedule (PM)
8.5
15.3


Cost
$47,000
$60,000


SLOC
8,400
10,400

Step 19: Once you are done, close both projects.

6.2.4.2
Project – Versions – Open: Opening a Version of a Project
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Selecting the File – Open menu option always opens the latest version of a project.  The Project – Versions – Open option allows you to select any version of a project to review from the Version Open dialog similar to the one in Figure 6-10.

Figure 6-10, Open Project Version Dialog

Step 20: Open the zSample project from the File – Open menu.  Notice that the version 1 is opened.  Select the Project – Versions – Open option.  Click the down arrow in the drop down box and select version 0.  Click the OK button and the zSample version 0 project will be loaded.  Select the Window – Tile Horizontally option to see both projects.  Notice that clicking on either one updates the status bar display for the active version.

6.2.5
Project – Compare: Comparing Two Versions of a Project

The last project menu option compares two versions of a project and reports the differences.  Selecting the Project – Compare option brings up the Compare Project Versions dialog similar to the one in Figure 6-11.  Select a different version of the active project in the drop down boxes, click the OK button and a report of the differences will be created and displayed in a new window.  The report can be saved or printed just as the other Project reports can.
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Step 21: Select the Project – Compare option from the menu.  Select version 0 for the first version and version 1 for the second version to compare.  Click the OK button.

Figure 6-11, Compare Project Versions Dialog

6.2.6
The Tools Menu

The Tools menu has a submenu that allows the toolbar and the status bar to be hidden or visible. And an option for setting program options.

6.2.6.1 Tools – View Submenu

The View submenu allow the toolbar and status bar to be hidden or displayed.  Open the submenu by selecting the Tools menu.  When the menu opens, place the mouse over the View submenu and it will open to show the Toolbar and Status Bar options.  A check mark in front of either of the options means it is currently visible.  Clicking on the option toggles the check mark and display.  The hot keys Ctrl+T also toggles the tool bar on and off while Ctrl+B toggles the Status Bar on and off

6.2.6.2
Tools – Options Option: Customizing the Program Outputs

Selecting the Options option brings up the Options dialog, Figure 6-12.  The Options Dialog contains two tabs.  Selecting the COCOMO tab allows the COCOMO constants to be adjusted to values used by your organization.  Selecting the PACTs tab allows the PACTs recommended by the program to be adjusted to time and cost estimates applicable to your organization and provide a description of the rationale used to apply the estimates.  It also allows the adjustment of the application of PACTs to different control levels.

Selecting the Cancel button closes the form ignoring all changes.  Selecting the OK button saves the changes and closes the form.

Figure 6-12, The Options Dialog

6.2.6.2.1
COCOMO Options

Two COCOMO options should be set prior to using the application.  Hours in a PersonMonth determine the number of actual working hours a typical manager, programmer and analyst will perform in a month.  This value should take into account work hours not performed due to vacation days, sick days and holidays.  The Average Hourly Rate should be the average rate used to estimate manpower costs.

6.2.6.2.1
PACTs Options

Pacts are the risk mitigations Ask Pete supplies to the ARRT application for risk balancing.  PACTs are recommended for each phase and activity based on the control level.  The options dialog allows you to customize the estimated time and money each PACT requires to be performed.  The control levels that a PACT is selected for can also be selected.  Initially, the application provides some estimates of PACT costs.  These values should be reviewed for applicability to you organization and modified as needed.  

PACTs are displayed by phase/activity.  Select the phase or activity from the drop down box to review the applicable PACTS.  Use the Next and Previous buttons to display each of the PACTS and their associated information.  A description of the PACT or the rationale for determining the cost can be entered in the Description text box

Selecting the Cancel button closes the form ignoring all changes.  Selecting the OK button saves the changes and closes the form.

PACTs cannot be added or deleted from the application.

6.2.6.3
Tools – Link Option: Linking Questions and Answers to Project Risk

The Link option provides the ability to provide links between software development risks and the Ask Pete questions and answers. When this option is selected, the dialog shown in Figure 6-13 is displayed.  The tree at the top of the dialog shows various project risks.  Ask Pete questions are selected from the dropdown combo box in the middle of the dialog.  When a question is selected, the allowable Ask Pete answers to the question are displayed in the list at the bottom of the dialog.  Risks may be associated with a question by selected the question and them clicking on the associated risk(s) in the tree.  More than one risk may be associated with a 
question.  Clicking the Close button closes the dialog and saves the link information between the questions and risks.  

This information is used to export risk information to the Shared database based on the questions answered and the answers selected.
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Figure 6-13, Link Dialog

6.2.6.4
Tools –Convert DB Option: Convert the Database Structure

The Convert DB option modifies the application’s database to include new fields or tables resulting from updates to the application.  This option is only available when all other windows are closed.  When the Convert DB option is selected, the application verifies that the database is the correct version.  If it is a message is displayed stating that the database is already at the current version.  If it isn’t then the conversion is attempted and if successful, a message is displayed stating the new version of the database.  Multiple conversions may be needed depending on the version of the database when the conversion is started.  Once the conversion is initiated, all needed conversions are performed automatically and messages are displayed once each version conversion is completed.

6.2.8
The Help Menu

The Help menu functions similar to other Microsoft Windows applications providing the ability to view the program’s help screens, view a splash screen showing the current version of the application and contact information, and a link to the Ask Pete Support web site if the user is connected to the Internet when the option is selected.

7.0 ERROR AND WARNING MESSAGES

There are currently no warning messages displayed by the program during normal operation.  In the event that a error occurs, a generic error message is displayed informing the user of the error number, error type and location of the error, i.e. “73 No record found mnuFilePrint.mdlMain”.

8.0
RECOVERY STEPS

This section is not applicable 

9.0
ABBREVIATIONS AND ACRONYMS

	Abbreviation/

Acronym
	Meaning

	PM
	Person Months

	ARRT
	Automated Risk Reduction Tool

	Ask Pete
	Acquired Software Knowledge – Project – Esffort – Tools - Estimation

	COCOMO
	COnstructive COst MOdel

	DID
	Data Item Description

	GRC 
	Glenn Research Center

	IA
	Independent Assessment

	IV&V
	Independent Verification and Validation

	JPL
	Jet Propulsion Lab

	KSLOC
	Thousand Source Lines Of Code

	Rich Text File
	A computer file type which saves font and layout formatting information

	SDP
	Software Development Manual

	SLOC
	Source Lines Of Code

	SPA
	Software Product Assurance

	SW
	Software


10.0
GLOSSARY

	Word
	Meaning

	Person Months
	The amount of hours a person will work during one month, typically 152.  Taking into account sick days and vacation days.

	Control Level
	The result of analyzing a project’s size, risk and complexity to determine the effort which must be expended to achieve success.  Determines the documentation and activities which must be performed on the project.

	InstallShield
	A computer program installation utility

	rtf
	File extension for Rich Text Files

	txt
	File extension for text files


 11.0
NOTES

This section is not applicable 

Appendix A - Distribution Files

This appendix lists the files included in the distribution file and the folders they should be installed in to run the application.  

Program files

	File
	Description 
	Destination

	AskPete.exe
	Program file
	\Program Files\NASAToolTime

	expert.mdb
	Data file
	\Program Files\NASAToolTime

	CMM.mdb
	Data file
	\Program Files\NASAToolTime

	UsersGuide.doc
	Documentation file
	\Program Files\NASAToolTime

	ProgrammersManual.doc
	Documentation file
	\Program Files\NASAToolTime

	Plan.rtf
	Template
	\Program Files\NASAToolTime

	AskPete.hlp
	Help file
	\Program Files\NASAToolTime\Help

	Shared.mdb
	Data file
	\Program Files\NASAToolTime\Shared

	mscomctl.ocx
	
	Windows system directory

	comdlg32.ocx
	
	Windows system directory

	tabctl32.ocx
	
	Windows system directory

	richtx32.ocx
	
	Windows system directory

	mscomct2.ocx
	
	Windows system directory

	comct332.ocx
	
	Windows system directory

	msdatsrc.tbl
	
	Windows system directory


VB RunTime files

	File
	Description 
	Destination
	Dependencies
	Version 

	Msvbvm60.dll
	Core Visual Basic 6.0 file
	Windows system directory
	Oleaut32.dll
	6.0.84.95 

	Oleaut32.dll
	Automation file 
	Windows system directory
	None
	2.40.4275.1 

	Olepro32.dll
	Automation file
	Windows system directory
	Oleaut32.dll
	5.0.4275.1 

	Stdole2.tlb
	Automation file
	Windows system directory
	None
	2.40.4275.1 

	Asycfilt.dll
	Automation file
	Windows system directory
	None
	2.40.4275.1 

	Comcat.dll
	Component categorization file 
	Windows system directory
	None
	4.71.1441.1 

	Vb5db.dll
	Database access file
	Windows System Directory
	Oleaut32.dll
	6.0.81.69 

	Vb6de.dll
	Database access file
	Windows System Directory
	Oleaut32.dll
	5.0.81.69 

	Vb6jp.dll
	Database access file
	Windows System Directory
	Oleaut32.dll
	5.0.81.69


DAO 3.6.1 Files

	File 
	Description 
	Destination 
	Dependencies
	Version 

	Dao360.dll
	Core DAO File 
	*
	Msvcrt40.dll, Oleaut32.dll, Msvcrt.dll
	3.60.2927.4 

	Asycfilt.dll
	Automation File 
	Windows systems folder
	
	2.40.4275.1 

	Msjint40.dll
	MS Jet Database Engine International DLL
	Windows systems folder
	Msjint.dll
	4.0.2927.2 

	Msjter40.dll
	MS Jet Database Engine Error DLL
	Windows systems folder
	
	4.0.2927.2 

	Msvcrt.dll
	Support File 
	Windows systems folder
	Msvcrt.dll
	6.0.8397.0 

	Msvcrt40.dll
	Support File 
	Windows systems folder
	
	4.22.0.0 

	Stdole2.tlb
	Automation File 
	Windows systems folder
	
	2.40.4275.1 

	Comcat.dll
	Component Categorization File 
	Windows systems folder
	
	4.71.1441.1 

	Oleaut32.dll
	Automation File 
	Windows systems folder
	Oleaut32.dll
	2.40.4275.1 

	Olepro32.dll
	Automation File 
	Windows systems folder
	Oleaut32.dll
	5.0.4275.1


* DAO360.DLL location: For Windows 95 or Windows NT 4.0, the DAO folder is %CommonFilesDir%\Microsoft Shared\DAO (where %CommonFilesDir% is the path stored in the registry value HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\CommonFilesDir).

File List for MDAC 2.1.2.4202.3 (GA) 
	File name
	Version

	12520437.cpx
	n/a

	12520850.cpx
	n/a

	adcjavas.inc
	n/a

	adcvbs.inc
	n/a

	adoapt15.reg
	n/a

	adofre15.reg
	n/a

	adojavas.inc
	n/a

	adomdrd.txt
	n/a

	adoreadm.txt
	n/a

	adovbs.inc
	n/a

	adoxrdme.txt
	n/a

	asycfilt.dll
	2.40.4275.1

	cliconf.hlp
	n/a

	cliconfg.DLL
	1999.4.5.0

	cliconfg.exe
	1999.4.5.0

	dbmsadsn.dll
	1999.4.5.0

	dbmsrpcn.dll
	1999.4.5.0

	dbmsshrn.dll
	1999.4.5.0

	dbmssocn.dll
	1999.4.5.0

	dbmsspxn.dll
	1999.4.5.0

	dbmsvinn.dll
	1999.4.5.0

	dbnmpntw.dll
	1999.4.5.0

	drvvfp.cnt
	n/a

	drvvfp.hlp
	n/a

	ds16gt.dll
	3.510.4202.0

	ds32gt.dll
	3.510.4202.0

	expsrv.dll
	6.0.0.8268

	HANDLER.reg
	n/a

	handsafe.reg
	n/a

	handunsf.reg
	n/a

	instcat.sql
	n/a

	jroread.txt
	n/a

	makapt15.bat
	n/a

	makfre15.bat
	n/a

	mdac.cmd
	n/a

	MDAC21RD.txt
	n/a

	msadce.dll
	2.10.4202.1

	msadcer.dll
	2.10.4202.1

	msadcf.dll
	2.10.4202.1

	msadcfr.dll
	2.10.4202.1

	msadco.dll
	2.10.4202.1

	msadcor.dll
	2.10.4202.1

	msadcs.dll
	2.10.4202.2

	msadds.dll
	2.10.4202.1

	msaddsr.dll
	2.10.4202.1

	msader15.dll
	2.10.4202.1

	msado15.dll
	2.10.4202.1

	msado20.tlb
	n/a

	msadomd.dll
	2.10.4202.0

	msador15.dll
	2.10.4202.1

	msadox.dll
	2.10.4202.0

	msadrh15.dll
	2.10.4202.1

	mscpxl32.dll
	3.60.3.20

	msdadc.dll
	2.10.4202.0

	msdaenum.dll
	2.10.4202.0

	msdaer.dll
	2.10.4202.0

	msdamg9x.dll
	2.50.4202.0

	msdaora.dll
	2.10.4202.0

	msdaosp.dll
	2.10.4202.1

	msdaprsr.dll
	2.10.4202.1

	msdaprst.dll
	2.10.4202.1

	msdaps.dll
	2.10.4202.0

	msdarem.dll
	2.10.4202.1

	msdaremr.dll
	2.10.4202.1

	msdasc.cnt
	n/a

	msdasc.dll
	2.10.4202.0

	msdasc.hlp
	n/a

	msdasc.txt
	n/a

	msdasql.dll
	2.10.4202.0

	msdasqlr.dll
	2.10.4202.0

	msdatl2.dll
	2.10.4202.0

	msdatsrc.tlb
	n/a

	msdatt.dll
	2.10.4202.0

	msdfmap.dll
	2.10.4202.1

	msdfmap.ini
	n/a

	msdsqlrm.txt
	n/a

	msexch40.dll
	4.0.2927.2

	msexcl40.dll
	4.0.2927.2

	msjet40.dll
	4.0.2927.2

	MSJETO~1.DLL
	4.0.2927.2

	msjint40.dll
	4.0.2927.2

	msjro.dll
	2.10.4202.0

	msjter40.dll
	4.0.2927.2

	msjtes40.dll
	4.0.2927.2

	msltus40.dll
	4.0.2927.2

	msorcl32.cnt
	n/a

	msorcl32.dll
	2.573.4202.0

	msorcl32.hlp
	n/a

	msorcolr.txt
	n/a

	msorcrdm.txt
	n/a

	mspbde40.dll
	4.0.2927.2

	msrclr40.dll
	4.0.2927.2

	msrd2x40.dll
	4.0.2927.2

	msrd3x40.dll
	4.0.2927.2

	msrecr40.dll
	4.0.2927.2

	msrepl40.dll
	4.0.2927.2

	mstext40.dll
	4.0.2927.2

	msvcirt.dll
	6.0.8168.0

	msvcrt.dll
	6.0.8397.0

	mswdat10.dll
	4.0.2927.2

	msxactps.dll
	2.10.4202.0

	msxbde40.dll
	4.0.2927.2

	mtxdm.dll
	1997.11.532.0

	mtxoci.dll
	1998.2.715.0

	odbc16gt.dll
	3.510.4202.0

	odbc32.dll
	3.510.4202.0

	odbc32gt.dll
	3.510.4202.0

	odbcad32.exe
	3.510.4202.0

	odbcbcp.dll
	3.70.6.90

	odbccp32.cpl
	3.510.4202.0

	odbccp32.dll
	3.510.4202.0

	odbccr32.dll
	3.510.4202.0

	odbccu32.dll
	3.510.4202.0

	odbcinst.cnt
	n/a

	odbcinst.hlp
	n/a

	odbcint.dll
	3.510.4202.0

	odbcjet.cnt
	n/a

	odbcjet.hlp
	n/a

	odbcji32.dll
	4.0.4202.0

	odbcjt32.dll
	4.0.4202.0

	odbctrac.dll
	3.510.4202.0

	oddbse32.dll
	4.0.4202.0

	odexl32.dll
	4.0.4202.0

	odfox32.dll
	4.0.4202.0

	odpdx32.dll
	4.0.4202.0

	odtext32.dll
	4.0.4202.0

	oleaut32.dll
	2.40.4275.1

	oledb32.dll
	2.10.4202.0

	oledb32r.dll
	2.10.4202.0

	oledb32x.dll
	2.10.4202.0

	olepro32.dll
	5.0.4275.1

	sqloledb.dll
	7.1.6.90

	SQLOLEDB.txt
	n/a

	sqlsodbc.hlp
	n/a

	SQLSOLDB.hlp
	n/a

	Sqlsrdme.txt
	n/a

	sqlsrv32.dll
	3.70.6.90

	sqlstr.dll
	1999.4.5.0

	sqlwid.dll
	1999.4.5.0

	sqlwoa.dll
	1999.4.5.0

	stdole2.tlb
	2.40.4275.1

	vbajet32.dll
	6.0.1.8268

	vfpodbc.dll
	6.0.8440.0

	vfpodbc.txt
	n/a
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